groov Server for Windows User’s Guide
Form 2078-230811—August 2023

Copyright © 2013–2023 Opto 22.
All rights reserved.
Printed in the United States of America.

The information in this manual has been checked carefully and is believed to be accurate; however, Opto 22 assumes no responsibility for possible inaccuracies or omissions. Specifications are subject to change without notice.

Opto 22 warrants all of its products to be free from defects in material or workmanship for 30 months from the manufacturing date code. This warranty is limited to the original cost of the unit only and does not cover installation, labor, or any other contingent costs. Opto 22 I/O modules and solid-state relays with date codes of 1/96 or newer are guaranteed for life. This lifetime warranty excludes reed relay modules, groov and SNAP serial communication modules, SNAP PID modules, and modules that contain mechanical contacts or switches. Opto 22 does not warrant any product, components, or parts not manufactured by Opto 22; for these items, the warranty from the original manufacturer applies. Refer to Opto 22 form 1042 for complete warranty information.

Wired+Wireless controllers and brains are licensed under one or more of the following patents: U.S. Patent No(s). 5282222, RE37802, 6963617; Canadian Patent No. 2064975; European Patent No. 1142245; French Patent No. 1142245; British Patent No. 1142245; Japanese Patent No. 2002535925A; German Patent No. 6001224.


ActiveX, JScript, Microsoft, MS-DOS, VBScript, Visual Basic, Visual C++, Windows, and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries. Linux is a registered trademark of Linus Torvalds. ARCNET is a registered trademark of DataPoint Corporation. Modbus is a registered trademark of Schneider Electric, licensed to the Modbus Organization, Inc. Wiegand is a registered trademark of Sensor Engineering Corporation. Allen-Bradley, CompactLogix, ControlLogix, MicroLogix, SLC, and RSLogix are either registered trademarks or trademarks of Rockwell Automation. CIP and EtherNet/IP are trademarks of ODVA. Raspberry Pi is a trademark of the Raspberry Pi Foundation. The registered trademark Ignition by Inductive Automation® is owned by Inductive Automation and is registered in the United States and may be pending or registered in other countries. CODESYS® is a registered trademark of 3S-Smart Software Solutions GmbH.

groov includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org)
All other brand or product names are trademarks or registered trademarks of their respective companies or organizations.

Opto 22
Your Edge in Automation.

Attributions: groov uses libraries and resources that individuals and groups around the world have made freely available over the web, including:
Font Awesome by Dave Gandy - http://fontawesome.io
Entypo pictograms by Daniel Bruce - http://www.entypo.com
Bootstrap 3 Datepicker - License at https://github.com/Eonasdan/bootstrap-datetimepicker/blob/master/LICENSE
Jamod - License at http://jamod.sourceforge.net/license.html
GWT Log - License at https://github.com/fredsa/gwt-log/blob/master/Log/LICENSE
# Table of Contents

## Chapter 1: Getting Started ................................................................. 1
- Welcome .......................................................................................... 1
- Try Before You Buy .......................................................................... 1
- For Help ........................................................................................... 2
- What You Will Need ........................................................................ 2
- Setting Up groov Server ................................................................. 2
  - Step 1. Activate groov Server ....................................................... 3
  - Step 2. Download Software ......................................................... 4
  - Step 3. Install Software .............................................................. 4
  - Step 4. Start groov View and Install the License File .................. 4
- Working with groov View ............................................................... 6
  - Create a New Username and Password ....................................... 6
  - Build a Sample Project ................................................................ 6
  - Add a Page .................................................................................... 7
  - Add a Device ............................................................................... 8
  - Add Device Tags .......................................................................... 9
  - Add Gadgets .............................................................................. 9
  - Save the Project .......................................................................... 12
  - View the Project on your Computer .......................................... 12
  - Explore ....................................................................................... 12
    - Images .................................................................................. 13
    - Round Gauge .......................................................................... 14
  - What's Next? ............................................................................. 15

## Chapter 2: Using an SSL Certificate ................................................ 17
- Using a Self-Signed Certificate ....................................................... 18
  - Step 1: Create a Self-Signed Certificate and Private Key .......... 18
  - Step 2: Add the Self-Signed Certificate to the Browser Trust Store on Client Computers ................................. 20
    - Windows ............................................................................ 20
    - OS X .................................................................................. 22
  - Step 3: Install a SSL Certificate on Mobile Devices .................. 22
    - iOS Devices ........................................................................ 22
    - Android Devices ................................................................... 23
- Using a CA-Signed Certificate ....................................................... 23
  - Step 1: Create a CSR ................................................................. 23
WELCOME

With groov Server for Windows you can easily build your own mobile operator interfaces—your own mobile apps—to monitor and control all kinds of automation systems and equipment.

groov Server for Windows provides groov View for building operator interfaces and using them. Although this groov View software is stored and served on a Windows PC, any computer with a web browser can be used to build interfaces. These operator interfaces can then be viewed on almost any mobile device or computer regardless of its manufacturer or operating system, including smartphones, tablets, PCs, and even web-enabled high-definition televisions.

Once installed, groov Server runs as a service on the server computer. This means that it starts when Windows does, and it continues to run in the background as long as Windows is running. In order to build or use groov View interfaces on any device, this PC must be on and groov Server must be running.

For instructions to build and use interfaces, see form 2027, the groov View User's Guide.

TRY BEFORE YOU BUY

A fully functional version of groov Server for Windows is available to download and try, so you can see your system data on your phone, tablet, or computer. Connect to a Modbus/TCP device, groov RIO module, SNAP PAC controller, SNAP PAC I/O unit, or groov Data Store; or use the built-in Data Simulator to evaluate groov View without connecting to a live machine or system.

If you want to connect to real data from an external OPC UA server and don’t have one, Kepware Technologies’ KEPServerEX® communication platform is available for trial at www.kepware.com.

To try groov View, download and install groov Server for Windows. Simple instructions walk you through software setup, connecting to one or more systems, and building a simple interface so you can quickly see realtime data on a mobile device.

NOTE: You must log into your computer as an administrator to install groov Server for Windows.

groov Server operates for two hours without a license key. You can restart it as needed. When you purchase a groov product, the project you built during the trial will continue to work. You can also develop your groov View operator interface on groov Server and later move your project to a groov EPIC.
WHAT YOU WILL NEED

To install and run groov Server for Windows you’ll need:

• A PC on the same network as your control device, with one of the following Microsoft® operating systems. If you’re using an external OPC UA server, groov can be on the same computer or a separate computer.
  – Windows® 11 Professional (32-bit and 64-bit)
  – Windows 10 Professional (32-bit and 64-bit)
  – Windows Server 2019
  – Windows Server 2016
  – Windows Server 2012 and 2012 R2

NOTE: .NET Framework 3.5 or greater is required for all operating systems. Use the “Add roles and features” option for Windows Server 2012.

• A minimum of 250 MB available disk space to install groov Server for Windows. Additional disk space is required to create projects. (Projects may be created on this PC or on a different computer.)

SETTING UP groov SERVER

Setting up groov Server for Windows is a four-step process: activate groov Server, download software, install software, and download and apply your License File. All steps except installing software require internet access.

If the PC where you plan to install groov Server has internet access, do all steps on that PC. Start with “Step 1. Activate groov Server” on page 3.

If the PC where you will install groov Server does not have internet access, you can use another PC to activate and download files. However, to download the License File, you need to know a MAC address on the PC where groov Server will be installed. To get it, go to the server PC and open a Command Prompt. Type ipconfig /all and look for “Physical Address.” It will be a hex value with 12 digits separated by hyphens into groups of two (example: 02-D0-65-1F-B7-20). Write it down, go to the PC with internet access, and follow the procedures starting with “Step 1. Activate groov Server” on page 3.

Multiple groov Server installations. If you plan to install groov Server on multiple PCs, here are some important things to know:

• The software download file is the same for all groov Servers for Windows, so if you are downloading from one PC and then installing on multiple other PCs, you need to download the software only once.
• Each groov Server must be individually activated using its Activation Key, because each purchase of groov Server is a separate installation.

• Each groov Server requires its own License File, which is tied to a MAC address for the PC on which it’s installed. If you download multiple License Files, you can tell them apart by the MAC address in the filename. Make sure the correct License File goes on each server PC.

Step 1. Activate groov Server

NOTE: If you already have the groov Server Installation File, skip to “Step 3. Install Software” on page 4.

1. Open a web browser (Firefox, Chrome, or Edge recommended). Go to manage.groov.com and log in using your email address and your My.Opto22 password. You may have set up your free My.Opto22 account when you purchased groov Server. If you don’t have a My.Opto22 account, enter your email address and other information, and the account will be created.

2. Click Activate.

3. Enter the Activation Key you received via mail or email when you purchased groov Server. Click Activate.
Your groov Server is activated.
Step 2. Download Software

On the groov Profile page in manage.groov.com, click the filename for the latest release and save the file to your computer.

(Optional) If you already know the MAC address of the PC where you’re installing groov Server, you can also get your License File now. To do so, enter it in the field and click Add MAC Address. Then click Download License File, and save the file to your PC.

Step 3. Install Software

NOTE: You must log in as an administrator to install groov Server for Windows.

1. On the PC where you want to install groov Server, double-click the groov Server installation file and follow the onscreen instructions.

2. When asked whether to open port 443 (needed to access groov View), check the box to open it unless you need to use a different port or want to open it manually. (See page 29 for instructions.)

   groov Server begins running as soon as it is installed. You can tell it’s running by the groov Monitor icon in the system tray. The little green arrow means it’s running.

Step 4. Start groov View and Install the License File

1. If you haven’t already started groov View, in your web browser type: https://localhost

   Make sure you include the s in https as the s indicates a secure connection.

   If you’re not on the PC that’s running groov Server for Windows, type https:// plus the hostname or IP address of the groov Server computer.

2. When your browser connects to groov View for the first time, accept the security warning. This is normal behavior for groov View. Your groov View data is protected by encryption, so you can safely accept the warning.

   For Chrome: Click “Proceed anyway.”
For Firefox:

a. Expand "I Understand the Risks."

b. Click Add Exception to open the Add Security Exception dialog box.

c. Select "Permanently store this exception."

d. Click Confirm Security Exception.

For Safari: Click Continue.

For Internet Explorer: Click "Continue to this website (not recommended)."

3. When prompted to add a license file to groov View, click the word "here" and follow the onscreen instructions.

4. After you have saved the license file on your PC, come back to the Licensing dialog box and click Install License.

5. Browse to the license file, then click Open.

   If you have any trouble opening groov View, check the groov Monitor icon in the system tray (lower right corner of the screen) to make sure groov Server is running. If you don’t see it, click the Show Hidden Icons arrow. For more about groov Monitor, see Chapter 3: Maintenance and Troubleshooting. If groov Server does not start, see Chapter 3: Maintenance and Troubleshooting.

   If groov Server is running but groov View does not open, see Troubleshooting in form 2027, the groov View User’s Guide.

WORKING WITH groov VIEW

Create a New Username and Password

Follow the on-screen instructions to create an administrator username and password for groov View. If the security warning appears again, accept it. Write down your Username and Password, and keep it in a safe place. **There’s no way to retrieve login information**, and you will need it each time you log in.

**CAUTION: If you lose your login information, you will not be able open your project.** There is no password recovery option! To log in to groov View again you’ll need to erase your project and start over. See “Erasing Your groov View Project” on page 31.

After you have completed the instructions in Welcome to groov, groov View opens in your web browser.

Build a Sample Project

To get started, let’s build a page using tags in the Data Simulator and then view it on the computer. Here’s what we’ll do:

- Add a page
- Add a device (page 8)
- Add device tags (page 9)
- Add gadgets (page 9)
- Save the project (page 12)
- View the project on your computer (page 12)
- Explore (page 12)

When Build mode opens, you see the workspace where you’ll build your operator interface:
Add a Page

1. In the Pages panel on the left side of the workspace, click Add Page.

2. Give the page a name and click the color block to choose a background color. For now, leave the page as Uncategorized and leave Access Rights as All Users. Click OK. The blank page appears in the center of the workspace.
Add a Device

1. In the Gadget Palette panel (lower right), click Configure Devices & Tags.

2. On the right side of the Configure Devices and Tags window, click Add New Device. Select Data Simulator.

3. Click Close.
Add Device Tags

1. In the Gadget Palette panel, click the plus sign next to Data Simulator.

2. Click the plus signs in the tree to see the tags in the device.

Add Gadgets

1. Expand the tree to find `bool Variable A`. Click this tag.
A list appears showing all the gadgets that work with this tag.

2. Click the LED gadget and drag it to the page you’re building.
3. Click the gadget to highlight it and notice that properties appear in the Gadget Properties panel (upper right).

4. Scroll down to see all the possible properties you can choose and adjust. Enter the following properties and watch how the LED gadget changes after each one.

<table>
<thead>
<tr>
<th>Property</th>
<th>You choose...</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Line 21</td>
<td>Tag name is replaced with label.</td>
</tr>
<tr>
<td>Alignment</td>
<td>Right</td>
<td>Label moves to right of gadget.</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>Label text becomes smaller (default is 16 pixels).</td>
</tr>
<tr>
<td>Text Size</td>
<td>Click</td>
<td>Button changes to show link broken. This means that the label text size you just chose (12) will affect only the Desktop &amp; Tablet view, not the Handheld view.</td>
</tr>
<tr>
<td>Font</td>
<td>Verdana</td>
<td>Font on the label text changes.</td>
</tr>
<tr>
<td>Text Styling</td>
<td>B</td>
<td>Label text is boldfaced (thicker).</td>
</tr>
</tbody>
</table>
5. Notice that part of the LED and its label text are hidden. Use your mouse to grab a corner handle on the gadget and pull it out so everything is visible.

![Image of LED gadget]

6. In the Gadget Palette, click \textit{bool Variable A} again. Click Button and drag it to the page, next to the LED. Click to highlight it. In the Gadget Properties area, enter the following:

<table>
<thead>
<tr>
<th>Property</th>
<th>You choose...</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors</td>
<td>Text: Deep Green</td>
<td>Text changes color.</td>
</tr>
<tr>
<td></td>
<td>Background: Silver</td>
<td>Silver background appears in gadget area.</td>
</tr>
<tr>
<td>Graphic Size</td>
<td>Uncheck Auto and choose 6</td>
<td>LED becomes larger.</td>
</tr>
<tr>
<td>On/Off Colors</td>
<td>True: Dark Green</td>
<td>LED color changes.</td>
</tr>
<tr>
<td></td>
<td>False: [Leave as is]</td>
<td>No change</td>
</tr>
</tbody>
</table>

7. With the button highlighted, adjust its handles so it's about as large as the LED gadget. Make sure you can see all the text.

Your page now looks something like this:
Save the Project
From the File menu, choose Save All Changes and Switch to groov View.

View the Project on your Computer
Your saved project opens in groov View.

Try it out! Click the button and see what happens.

Explore
1. Go back to Build mode by clicking Menu in the upper-right corner of the window and choosing Switch to Build mode.
2. Click the Handheld tab, just above your page in the center of the workspace.
   While you were building your page in the Desktop & Tablet tab, groov View automatically put the same gadgets in the Handheld tab, which shows the page layout for a smartphone. However, you may want the page to look different on a phone. Maybe some data or controls are more important and should be at the top of the page. Or maybe some don’t need to be on the phone at all. In this tab you can resize, rearrange, change, or delete gadgets to suit your needs.
3. Click to highlight each gadget and change its size and position the way you want.
Remember that you made the text size smaller (12 instead of 16) for both the LED and the button? You also broke the link between the two views for that property, which means you changed it for one view only. So the text is smaller for Desktop & Tablet, but for Handheld it remains at the default of 16.

You can make the two views different in other ways as well. For example, suppose you want smartphone users to be able to see the status of Line 21 but not be able to turn it on or off. You can stash the Turn ON/OFF button so it’s not visible in the Handheld view.

4. In the Handheld tab, notice the area off to the right of the page with a dotted line around it. Drag the Turn ON/OFF button into this area, which is called the page stash.

The button will still be shown on a computer or tablet but will not be visible on a smartphone. You can also stash gadgets in the Desktop & Tablet tab if you don’t want them to appear on these devices, so you can customize the view on large and small devices.

Now let’s explore some more.

Images

When we added the Turn ON/OFF button, one of the properties was Display Mode. Let’s take another look at that now.

1. In the Desktop & Tablet tab, select the Turn ON/OFF button and look in the Properties panel.
2. For Display Mode, choose Image.

As you can see, instead of a simple button, you could skin the button with images: one image indicates that the button is On and the other that it is Off.

3. Click a broken image to open the Image Library, where you can add images to your project. All the images for your groov project are stored in the Library. You can add and delete images. You can use the same image in multiple places, and if you change it, it’s automatically updated everywhere it’s used. Compatible file types for images are BMP, GIF, PNG, JPG, and SVG. For more on the Image Library, see the groov View User’s Guide.
Here’s what the Image Library looks like before you’ve added any images:

![Image Library](image)

4. For now, click Cancel to exit the Image Library. In the Properties panel, change Display Mode back to Button.

**Round Gauge**

Let’s look at a gauge.

1. In the Gadget Palette, expand the tag tree again. Under Basic > Variables, choose `float32 Variable A`. In the gadget list, click Round Gauge and drag it to your page.
2. Highlight the new gadget and look at its properties. To understand all the options, see “Gadget Reference” in the *groov View User’s Guide*. But for now, change only the following:

<table>
<thead>
<tr>
<th>Property</th>
<th>You choose...</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>Min value 0, Max value 100</td>
<td>The gauge changes to show 0-100.</td>
</tr>
<tr>
<td>Units</td>
<td>Gallons</td>
<td>“Gallons” appears below the numeric value on the gauge.</td>
</tr>
<tr>
<td>Precision</td>
<td>0</td>
<td>Value will be shown in whole numbers (no digits after the decimal point).</td>
</tr>
<tr>
<td>Colors</td>
<td>Needle: Black Background: Dark Orange</td>
<td>Colors change on the gauge.</td>
</tr>
</tbody>
</table>

3. Scroll down to Color Ranges and click Add Range.

![Color Ranges](image)

4. Click the blue rectangle and choose Red. Enter Min Value 0 and Max Value 20.
5. Click Add Range again. For Color, choose Orange. Enter Min Value 20 and Max Value 40.
6. Click Add Range again. For Color, choose Dark Green. Enter Min Value 40 and Max Value 100. Your gauge now looks like this:

This gauge is easy for an operator to understand at a glance. Anything in the green range is OK, but if the needle dips down into the red, you have a problem.

The numeric value appears in blue at the bottom of the gauge.

What’s Next?

Now that you have an idea of what groov View can do, you’re ready to work on your real project. See the groov View User’s Guide (form 2027) for much more information, including:

- Adding the devices you want to monitor and control
- Choosing gadget properties
- Setting up authorized user accounts
- Logging events and sending notifications
groov View uses an SSL certificate to encrypt communications and prove groov View’s identity to client browsers. An SSL certificate contains the server name, the name of the organization that controls the server, and digital signatures of organizations that vouch for the authenticity of the certificate. The certificate is digitally signed either by a certificate authority (CA) or it is self-signed.

The default certificate type (a self-signed certificate) and configuration will cause your web browser to issue an untrusted site warning when accessing groov View. To avoid the warning you can install the self-signed certificate in all the browser certificate stores used to access groov View. However, whether or not the certificate is installed in the certificate stores, communication is always encrypted.

Here's a comparison of the certificate types:

<table>
<thead>
<tr>
<th></th>
<th>Self-Signed Certificate (default)</th>
<th>Self-Signed Certificate installed on all browser certificate stores</th>
<th>CA-Signed Certificate</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Best Use</strong></td>
<td>For one or two groov View installations and a small set of client browsers that remain pretty much the same, and users who trust that your certificate is valid</td>
<td>Same as default, plus it avoids seeing the untrusted site warning from the browser</td>
<td>Use with a system with many groov View installations or when the set of browsers that will access groov View is unknown or changes frequently, or if users will not trust your self-signed certificate</td>
</tr>
<tr>
<td><strong>Cost</strong></td>
<td>Free</td>
<td>Free</td>
<td>Free Public CA-signed certificates cost anywhere from $9 to $100 or more per year</td>
</tr>
<tr>
<td><strong>Ease of Configuration</strong></td>
<td>Easiest configuration</td>
<td>Must install in the browser certificate store for every browser that accesses the server</td>
<td>More complex initial configuration because a certificate authority signature must be obtained</td>
</tr>
<tr>
<td><strong>Untrusted Site Warning</strong></td>
<td>Browser raises untrusted site warning. (But communication is still encrypted.)</td>
<td>No untrusted site warning from browser</td>
<td>No untrusted site warning from browser. Trusted by all major browsers.</td>
</tr>
<tr>
<td><strong>Trust Level</strong></td>
<td>Trusted by those to whom the groov View administrator has demonstrated the validity of the certificate (e.g. by providing the certificate thumbprints).</td>
<td>Trusted by those who trust the groov View administrator enough to install or let him or her install the certificate in their browser certificate store</td>
<td>Trusted by everyone</td>
</tr>
</tbody>
</table>

If you are using a **self-signed certificate**, see “Using a Self-Signed Certificate” on page 18.

If you are using a **CA-signed certificate**, see “Using a CA-Signed Certificate” on page 23.
USING A SELF-SIGNED CERTIFICATE

A self-signed certificate encrypts communications, but does not include a digital signature from a commercial CA. It is free and easy to configure, but if you want to avoid having your users see an untrusted site warning every time they use groov View, you must install the self-signed certificate in the browser certificate store for every browser that will access groov View. This type of certificate is a good solution for a small set of groov View installations and a small set of client browsers that you can configure.

Follow these steps to create and install a self-signed certificate:

*Step 1: Create a Self-Signed Certificate and Private Key* on page 18
*Step 2: Add the Self-Signed Certificate to the Browser Trust Store on Client Computers* on page 20
*Step 3: Install a SSL Certificate on Mobile Devices* on page 22

Step 1: Create a Self-Signed Certificate and Private Key

Follow the steps below to generate the following components required to configure self-signed certificate SSL communication.

- **Private Key**: This must be kept secret and never shared. Keep a copy of it in a safe and secure place.
- **Signed Certificate**: Contains identification information, the public key, and a digital signature. Identification information includes the server name and the name of the organization that controls the server. The self-signed certificate is digitally signed by the Private Key to establish authenticity. The certificate is automatically installed on the groov Server.

Creating a self-signed certificate also generates in the groov folder a certificate-signing request (.csr) file that you can use to get an SSL certificate from a Certificate Authority. See "Using a CA-Signed Certificate" on page 23.

**NOTE:** You must have administrator privileges to use the SSL Certificate utility.

To generate a private key and self-signed certificate:

1. On the computer where groov Server is installed, do one of the following:
   - For Windows 7 and Windows Server 2008, choose Start > All Programs > Opto 22 > groov > groov SSL Certificate.
   - For Windows 8, click the groov SSL Certificate utility metro tile.
   - For Windows Server 12, navigate to the directory where groov was installed (C:\Program Files (x86)\Opto22\groov, by default). The SSL Certificate Utility is in the “bin” folder. Start the utility. The utility opens in a DOS window.

2. Enter 1 and press RETURN.
3. Enter the information requested by the onscreen instructions, including the following.
Server Name—Enter the fully qualified hostname of this groov Server that client browsers will use to access groov (i.e. the hostname and domain name, such as mobilehmi.mydomain.com.) The server name may contain letters a–z (case insensitive), digits 0–9, or a hyphen (-). No other characters are allowed. The server name must not start with a hyphen.

Example:
If the URL you will use to access groov in client browsers is https://process1.acme.com enter process1.acme.com

Example:
If the URL client browsers will use to access this groov Server is https://mobilehmi.mydomain.com enter mobilehmi.mydomain.com

Department: Use this field to differentiate between divisions within an organization. For example, “Engineering” or “Manufacturing.” If applicable, you can enter the DBA (doing business as) name in this field.

Organization: The legally registered name of your business. The listed organization must be the legal registrant of the domain name in the certificate request. If you are enrolling as a small business or sole proprietor, please enter the certificate requester’s name in this field, and the DBA (doing business as) name in the Organizational Unit field.

City or Location: Name of the city or locality where your organization is located. Please spell out the name of the city or locality. Do not abbreviate.

State: Name of state, province, region, territory where your organization is located. Please enter the full name. Do not abbreviate.

Two-Letter Country Code: The two-letter International Organization for Standardization (ISO-) format country code for the country in which your organization is legally registered. See http://www.digicert.com/ssl-certificate-country-codes.htm for a list of codes. For example, the code for the United States is US.

Days until expiration: Enter the number of days before the certificate is expired and has to be replaced. We recommend 3560 (10 years).

The utility will stop groov Server, install the new private key and certificate, and then restart groov Server. When successful, the following message appears.

The following files are created and placed in the directory where groov was installed (C:\Program Files (x86)\Opto22\groov, by default).
- groov.key (private key)
- groov.cer (self-signed certificate)
- groov.csr (certificate signing request)
4. Press any key to exit.

Step 2: Add the Self-Signed Certificate to the Browser Trust Store on Client Computers

To prevent the untrusted site warning in browsers, the self-signed certificate must be added to the trust store for each browser used to access groov View. This step describes how to add the self-signed certificate on a computer. See the section below for the client computer’s operating system.

“Windows” on page 20

“OS X” on page 22

If you want to add a self-signed certificate on a mobile device, see Step 3.

Windows

Internet Explorer & Chrome.

1. In Windows file explorer, browse to the groov.cer file you created previously. See “Step 1: Create a Self-Signed Certificate and Private Key” on page 18).

   This file is available in the directory where groov Server was installed (C:\Program Files (x86)\Opto22\groov, by default).

2. Right-click on the certificate file groov.cer and choose Install Certificate to open the Certificate Import Wizard.

3. (Windows 8 only) If you are administrator of local machine, choose the Local Machine certificate store so this certificate will be trusted by all user accounts. Otherwise it will only be trusted by the current user account.

4. Click Next.

5. Select “Place all certificates in the following store.”

6. Click Browse to open the Select Certificate Store dialog box.
7. Select Trusted Root Certification Authorities, then click OK.
8. Click Next.
9. Click Finish.
10. A security warning alerts you that certificate installation is a risk if you don’t trust the certificate.
11. Click Yes to affirm that you trust the self-signed certificate.
12. To verify the certificate was installed correctly, open Internet Explorer or Chrome and enter the hostname specified on the certificate. If the browser does not generate an untrusted site warning, the certificate was installed correctly.

Firefox.

The self-signed certificate is added to the certificate store by adding a security exception. Firefox will present several warnings about creating a security exception for a self-signed certificate, but because you created and control the private key and certificate and installed the private key on the server, you can trust the certificate identifies your server.

1. Open Firefox and enter https://<server name>
   A warning appears that says, “This Connection is Untrusted.”
2. Expand “I Understand the Risks.”
3. Click Add Exception to open the Add Security Exception dialog box.
4. Select “Permanently store this exception.”
5. Click Confirm Security Exception.

6. To verify the certificate was installed correctly, open Firefox and enter the hostname specified on the certificate. If the browser does not generate an untrusted site warning, the certificate was installed correctly.
OS X

Safari and Chrome.
1. Open Safari and enter https://<server name> to open this dialog box:

2. Click Show Certificate to reveal the full details:

3. If the certificate looks good to you, check the “Always trust <server name> when connecting to <server name>“ and click Continue. You will be asked to provide your password to authorize the addition of this certificate to your keychain, after which the browser and the Hosted Projects window will accept the SSL certificate as valid.

4. To verify the certificate was installed correctly, open a browser and enter the hostname specified on the certificate. If the browser does not generate an untrusted site warning, the certificate was installed correctly.

Step 3: Install a SSL Certificate on Mobile Devices

When you open the operator interface in a browser on a smart phone or tablet a security warning will appear unless you have installed a self-signed or third-party SSL certificate. See the section below for the device’s operating system.

• “iOS Devices” on page 22
• “Android Devices” on page 23

iOS Devices
1. Email the groov.cer file you created previously (see “Step 1: Create a Self-Signed Certificate and Private Key” on page 18) to an email account accessible from iOS.

This file is available in the directory where groov Server was installed (C:\Program Files (x86)\Opto22\groov, by default).
2. On the iOS device, open the email message containing groov.cer.
3. Tap on groov.cer
4. A message appears, “The authenticity of <server name> cannot be verified...”
5. Click Install.
6. Click Install Now.
7. Click Done.
8. To verify the certificate was installed correctly, open a browser and enter the hostname specified on the certificate. If the browser does not generate an untrusted site warning, the certificate was installed correctly.

Android Devices
1. Email the groov.cer file you created previously (see “Step 1: Create a Self-Signed Certificate and Private Key” on page 18) to an email account accessible from Android.
   - This file is available in the directory where groov Server was installed (C:\Program Files (x86)\Opto22\groov, by default).
2. On the Android device, open the email and click the groov.cer file to install the certificate.
3. When prompted for a certificate name, type in a name. Make sure “Credential use:” is set to “VPN and apps.”
4. Click OK.
5. To verify the certificate was installed correctly, open a browser and enter the hostname specified on the certificate. If the browser does not generate an untrusted site warning, the certificate was installed correctly.

USING A CA-SIGNED CERTIFICATE

If groov Server is installed on a network that is exposed to the Internet, Opto 22 strongly recommends obtaining an SSL certificate from a third-party vendor called a certificate authority. When installed on groov Server and the devices that access groov View, the certificate validates the connection between the user and groov View, and it alerts users if they are re-directed to another groov Server on a different network.

So long as you stay connected directly to groov View on a secure connection (using https) you are protected from a man-in-the-middle attack.

The cost of a certificate from a certificate authority ranges from free to $300 or more, depending on the features and company you buy them from. Please work with your IT department if you choose this option.

Creating a self-signed certificate generates in the groov folder a certificate-signing request (.csr) file that you can use to get an SSL certificate from a Certificate Authority.

NOTE: You must have administrator privileges to use the SSL Certificate utility.

Follow these steps to create a certificate signing request (CSR) and install a CA-signed certificate:

“Step 1: Create a CSR” (see page 23)
“Step 2: Obtain a CA-Signed Certificate” (see page 25)
“Step 3: Install the CA-Signed Certificate on the Computer” (see page 25)

Step 1: Create a CSR

IMPORTANT: This procedure will create and install a new private key on the groov Server.
You will send the CSR to the Certificate Authority (CA) of your choice. The CA verifies the identification information and signs the CSR, which then becomes a CA-signed Certificate.

To create a certificate signing request (CSR), you’ll use the SSL certificate utility to generate a self-signed certificate. This will also generate the CSR.

1. On the computer where groov Server is installed, do one of the following:
   – For Windows 7 and Windows Server 2008, choose Start > All Programs > Opto 22 > groov > groov SSL Certificate.
   – For Windows 8, click the groov SSL Certificate utility metro tile.
   – For Windows Server 12, navigate to the directory where groov was installed (C:\Program Files (x86)\Opto22\groov, by default). The SSL Certificate Utility is in the “bin” folder. Start the utility.

   The utility opens in a DOS window.

2. Enter 1 and press RETURN.

3. Enter the information requested by the onscreen instructions, including the following.
   - **Server Name**—Enter the fully qualified hostname of this groov Server that client browsers will use to access groov (i.e. the hostname and domain name, such as mobilehmi.mydomain.com). The server name may contain letters a–z (case insensitive), digits 0–9, or a hyphen (-). No other characters are allowed. The server name must not start with a hyphen.
     
     *Example:*
     
     If the URL you will use to access groov in client browsers is
     https://process1.acme.com
     enter process1.acme.com
     
     *Example:*
     
     If the URL client browsers will use to access this groov Server is
     https://mobilehmi.mydomain.com
     enter mobilehmi.mydomain.com

   - **Department**: Use this field to differentiate between divisions within an organization. For example, “Engineering” or “Manufacturing.” If applicable, you can enter the DBA (doing business as) name in this field.

   - **Organization**: The legally registered name of your business. The listed organization must be the legal registrant of the domain name in the certificate request. If you are enrolling as a small business or sole proprietor, please enter the certificate requester’s name in this field, and the DBA (doing business as) name in the Organizational Unit field.

   - **City or Location**: Name of the city or locality where your organization is located. Please spell out the name of the city or locality. Do not abbreviate.

   - **State**: Name of state, province, region, territory where your organization is located. Please enter the full name. Do not abbreviate.
Two-Letter Country Code: The two-letter International Organization for Standardization (ISO-) format country code for the country in which your organization is legally registered. See http://www.digicert.com/ssl-certificate-country-codes.htm for a list of codes. For example, the code for the United States is US.

Days until expiration: Enter the number of days before the certificate is expired and has to be replaced. We recommend 3560 (10 years).

The utility will stop groov Server, install the new private key and certificate, and then restart groov Server. When successful, the following message appears.

The following files are created and placed in the directory where groov was installed (C:\Program Files (x86)\Opto22\groov, by default).
- groov.key (private key)
- groov.cer (self-signed certificate)
- groov.csr (certificate signing request)

4. Press any key to exit.

Step 2: Obtain a CA-Signed Certificate

A CA-signed certificate contains identification information, the public key, and a digital signature. Identification information includes the server name and the name of the organization that controls the server. The certificate is digitally signed by a CA to establish authenticity. The Certificate is installed on the computer where groov Server for Windows is installed.

When you apply for an SSL certificate from a certificate authority, you will need to send them a Certificate Signing Request (CSR). If you have not yet created a CSR file, see “Step 1: Create a CSR” on page 23.

When filling out a form for a certificate authority, keep in mind that an SSL certificate can be used with any operating system. If you are asked to select an operating system, you can select “other” if that is an option, but it’s OK to select some other operating system.

1. Provide the text to the certificate authority in whatever form they require, whether it’s a text file or just text pasted into a text field.
2. Finish the transaction with the certificate authority and receive your new SSL certificate.

Step 3: Install the CA-Signed Certificate on the Computer

1. On the computer where groov Server is installed, do one of the following:
   - For Windows Server 12, navigate to the directory where groov Server was installed (C:\Program Files (x86)\Opto22\groov, by default). The SSL Certificate Utility is in the “bin” folder. Start the utility. The groov SSL Certificate utility opens in a DOS window.
2. Enter 2 and press RETURN.
   The following message appears.

   Sometimes the CA signed certificate is signed with an intermediate certificate instead of a root certificate. In this case all intermediate certificates in the chain of trust between your certificate and the root certificate should be gathered into one chain file and installed on groov Server.
   Install a chain file? [y/n]:

3. If you are unsure, enter n.
   A prompt says, “Provide the path and file name of the private key file.”

4. Enter the path and file name of the groov.key file if it’s the currently installed key.
   A prompt says, “Provide the path and file name of the certificate file.”

5. Enter the path to the CA-signed certificate file.
   For example, C:\Certificates\sub.class1.server.ca.pem

When the operation has finished, a message says “Installed successfully.”
3: Maintenance and Troubleshooting

STARTING AND STOPPING groov SERVER

groov Server must be running on the Windows computer where it’s installed in order for anyone on any device to use groov View for building or viewing operator interfaces.

If you need to stop groov Server or start it again, you can use the Windows control panel or groov Monitor. groov Monitor is a utility that starts with groov Server but runs independently from the service and lets you see information about it.

*NOTE: You must have administrator privileges to use groov Monitor.*

To use groov Monitor:

1. In the Windows notification area of the taskbar, find the groov Monitor icon . (If you don’t see it, click the Show Hidden Icons arrow.)
2. To check whether groov Server is running or stopped, look at the icon or hover over it.

3. For other options, right-click the icon. Use the commands as follows:

   ![groov Monitor commands](image)

*Start groov Server* and *Stop groov Server* affect the groov Server service.

*About groov Server* shows groov Server’s version number and other information.
Click **Network Info** to see hostname, MAC addresses, and other information helpful for using *groov Server*:

![Network Info](image)

**Host Name**—Typically part of the URL when you access *groov View* from another computer or from a tablet or smartphone. You open a web browser and type `https://` plus this hostname.

**MAC Address**—Use one of these to get your *groov* Server License File, which is required to use *groov View*. See steps on page 2.

**IP Address**—If your network does not use hostnames, you can access *groov View* from another computer/tablet/smartphone by opening a web browser and typing `https://` plus the IP address.

**Exit *groov Monitor*** closes *groov Server* Monitor only. The icon disappears. Exiting *groov Server* Monitor does not affect the *groov Server* service. If the service is running, it will continue to run after you exit Monitor.

To start *groov Server* Monitor again, search Windows for “*groov Monitor*”.

If *groov Server* is stopped, starting the monitor will **not** start the service. To start the service again, use *groov Monitor*’s Start command.

You can also stop, start, or restart *groov Server* in the Windows control panel:

4. Open the Windows Control Panel and click Administrative Tools.

   In Windows 7, if the control panel is viewed by category, Administrative Tools is in the System and Security group.

5. Double-click Services.

6. Select *groov Server*.

7. Click the command you want to use.
CHANGING AND OPENING THE groov VIEW SSL PORT

By default groov View communicates on port 443.

Changing the groov View Port

If you want to change the SSL port number, first consult with your IT manager. If you change the port, you will need to use the following format when connecting to groov Server:

https://localhost:port

where port is the new port number. For example if the new port number is 888, you enter

https://localhost:888

To change the SSL port, follow these steps:

1. In Notepad or a similar program, open the start.ini file installed on the groov Server computer.
   - Find the file in the directory where groov Server was installed (C:\Program Files (x86)\Opto22\groov\app\start.ini, by default).
   - You need administrator rights to edit the start.ini file.
   - If you encounter issues editing the file directly from the directory, you may want to copy the start.ini file to another location (for example, the Desktop), make the changes in that copy, then copy it back to the directory.
2. Scroll through the file until you find the following section:
   ```
   ## Connector host/address to bind to. On Windows we listen on all interfaces.
   jetty.ssl.host=0.0.0.0
   jetty.ssl.port=443
   ```
3. Change only the port number.
4. Save and close the file.
5. Restart groov Server:
   a. Open the Windows Control Panel and click Administrative Services.
   b. Select groov Server.
   c. Click Restart.
Manually Opening Ports

When you install groov Server, you’re given the option to have the groov View SSL port 443 opened automatically. If you didn’t choose this option, you'll need to open the port manually. Steps may vary depending on your version of Windows.

1. On the computer where groov Server is installed, choose Start > Control Panel > Windows Firewall.
2. Click Advanced Settings.
3. Create an Inbound Rule for the Program groov View. (By default, groov View is installed in C:\Program Files (x86)\Opto22\groov).
4. Restart groov Server (see “Starting and Stopping groov Server” on page 27).

Getting groov Server Updates

Because you have activated groov Server, you are eligible to receive updates. Updates add new capabilities and fix issues that may arise.

Each groov Server installation is treated independently, so you must activate each one; updates are valid for a specific groov Server installation only.

To install an update, download the update file and then run the installation.

If updates are available, an updates icon appears next to the groov logo in the upper-right corner in Build mode. Click the updates icon (or choose Help > Check for Updates).

The Check for Updates dialog box tells you what kind of updates are available. Follow the onscreen instructions to download an update file or view a list of updates on the latest groov Server readme.

Another way to check for updates is to go directly to manage.groov.com.

1. Log in with your MyOpto username and password, and click Manage.
2. Locate your groov Server in the list and click Manage next to its name.
3. Click the Latest Release filename to download and save the file to your computer.
4. **Before installing the new version**, save any changes in your project and back up your project (see page 31).
5. Double-click the downloaded update file and run the installation.

**ERASING YOUR groov VIEW PROJECT**

If you’ve forgotten your password and can’t log in, or if you just want to start your project over again from scratch, you can delete the project as follows. Also see the next section, “Backing Up and Restoring Your Project.”

   For help, see “Starting and Stopping groov Server” on page 27.
2. Navigate to the groov View installation directory.
   Usually this is \%Program Files\%Opto22\groov.
3. Find the project file named project.grv.
4. **If you are sure you don’t want to keep the project**, delete the project file. Otherwise, archive the project by moving or renaming the project file.
5. Restart groov Server.

**BACKING UP AND RESTORING YOUR PROJECT**

You should back up groov View frequently because there is no automatic backup. During backup, your project is saved to a file on your computer.

**IMPORTANT:** Your groov View project files are not encrypted or masked in any way. This means that most of the project information in them (except for the groov View user passwords) can be read, including the following:

- **SMTP account info (including password)**
- **User email accounts** (does not include the groov View user passwords, which are securely encrypted before being stored)
- **Device addresses**
- **Tag address information** (PAC tag names, Modbus addresses, OPC node-id, etc.)

Opto 22 recommends that you secure your backup files using file- or disk-based encryption provided either by the operating system or other software/hardware.

Also, be aware that if you send project files to Opto 22, our personnel will have access to the information listed above.

**To back up your project:**

1. Choose File > Backup Project to Computer.
2. Check the boxes to include trend data and event notifications in the backup or to exclude user data. You might want to exclude user data, for example, if you are sending the backup to Opto 22 Product Support for help with an issue.

3. Click Download Project.

A backup file is downloaded to your computer.

To restore your project from a backup file:

**CAUTION**: Restore your project only if you have to. You will lose all work done since the last backup, and all users will be logged out.

4. Select File > Restore Project from Computer.

5. In the Restore Project dialog box, browse to the location of your tar.gz backup file.
6. Enter the username and password for the Admin account.

7. Click Restore.
   The following warning appears.

8. If you’re ready to proceed, click OK.
   When the restoration process is complete, the restored project opens in groov View.

TRANSFERRING groov SERVER TO SOMEONE ELSE

In some situations, you may need to transfer ownership of groov Server to someone else, so that person can install updates or licenses or modify groov View. For example, if you are a system integrator or OEM, you may have set up PCs with groov Server or included them in your machines and now need to transfer them to your customers.

**IMPORTANT:** When you transfer a groov Server to someone else, you will no longer be able to see or manage it in your list of groov products on manage.groov.com. Only the new owner will be able to do that.

Transferring a groov Server to someone else assumes that the PC groov Server is installed on is also being given to that person, so that the MAC address is correct. If you need to install groov Server on a different computer or change the MAC address for any reason, see “Transferring groov Server to a Different Computer or Network Card” on page 34.

**Exception: Owner Not Available**

If the person who owns groov Server is no longer available (for example, has left the company and cannot be reached), contact Opto 22 Product Support (see page 2). Have the following information ready for the Product Support engineer:

- E-mail address of the person groov Server is currently registered to
- E-mail address of the person it should be transferred to
- MAC 0 address for the PC where groov Server is installed

**Transfer Steps**

Assuming you are the current owner, follow these steps to transfer groov Server to someone else:

1. Log into manage.groov.com with your MyOpto username and password.
2. Click Manage.
3. In your list of groov products, find the Server you want to transfer and click the Manage button next to it.
4. At the bottom of the groov Profile page, click Transfers.
5. Enter the email address of the person you are transferring the Server to (the transferee) and double-check to make sure it is the correct address. Then click Transfer groov.

   You receive a confirmation email. If you've made an error, you can cancel the transfer unless the transferee has already accepted it.

   The transferee receives an email asking them to accept or decline the transfer at manage.groov.com. If they don't already have a free My.Opto account, they will need to register for an account.

   When the transferee accepts the transfer, the groov Server disappears from your list and appears in their list.

   If you have any problems with the transfer, contact Opto 22 Product Support (see page 2).

TRANSFERRING groov SERVER TO A DIFFERENT COMPUTER OR NETWORK CARD

When you first activate groov Server, you enter the MAC address of the computer it’s installed on. If you later need to move groov Server to a different computer, contact Opto 22 Product Support for help (see page 2). Have the following information available for the Product Support engineer:

• E-mail address of the person groov Server is currently registered to
• MAC Address of the current network card/computer
• MAC Address of the new network card/computer

TROUBLESHOOTING

groov Server doesn’t start

groov Server normally starts as soon as it is installed, even though no window opens. Check to see if the groov Monitor icon is in the system tray. (If you don’t see it, click the Show Hidden Icons arrow.) Hover over the icon with your mouse to see groov Server status.

If status shows “Stopped,” right-click the icon and choose Start groov Server from the popup menu. If the status shows “Running,” try stopping groov Server and then starting it again.

If you can’t find the icon, from the Start menu choose “groov Monitor.” See “Starting and Stopping groov Server” on page 27 for more information.

If groov Server fails to start, there might be a conflict with another service running on your computer. In this case, you might need to change the SSL port groov Server uses to run. To change the port number, first consult with your IT manager, and then follow steps in “Changing the groov View Port” on page 29.

The following command can be run at a command prompt to see what application (if any) is listening on port 443:

```
netstat -a -n -p tcp -b
```

Cannot read or write to a Modbus/TCP device OR the data doesn’t make sense

Modbus/TCP devices, though based on a standard protocol, may be set up differently from one another. Some use zero-based addressing and some use one-based addressing. Some devices don’t support all Modbus functions. Modbus/TCP devices also vary in the way they present float data. And device documentation sometimes doesn’t specify how the device is set up.
If you’re having trouble reading or writing to your device, or if the data is clearly wrong, you probably need to change settings for your Modbus device. In Build mode, choose Configure > Devices and Tags and locate your device in the list. Follow instructions in the groov View User’s Guide to understand and change settings. You may need to try different combinations of settings to see what works.

Problems with groov View

See the Troubleshooting chapter in the groov View User’s Guide. To open the user’s guide in Build mode, choose it from the Help menu.

For Help

Product support for groov Server is free. See “For Help” on page 2 for contact information.